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Introduction

This demonstration guide follows the list from Table 1 (page 2), which 

shows the transmitter tests deined by the 3GPP in the document of 

TS34.142 and TS34.122 for base station and mobile (user equipment) 

transmitters, respectively. Each demonstration is given a brief description 

of its function and the corresponding measurement steps on the signal 

generator and/or signal analyzer. 
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TD-SCDMA Test Standards  
and Measurement Applications

Table 1. TD-SCDMA transmitter test of base station and mobile station

3GPP TS25.142/

TS34.122  

paragraph no.

Transmitter test TD-SCDMA measurement application function

6.2/5.2 Maximum output power Transmit power

6.3/5.3 Frequency stability  OBW or modulation accuracy  

(Tx frequency error)

6.4/5.4.2 Output power dynamics Transmit power

6.5.1/5.4.3 Transmit OFF power Power vs time

6.5.2/5.4.5 Transmit ON/OFF time mask Power vs time

6.6.1/5.5.1 Occupied bandwidth Occupied BW

6.6.2.1/5.5.2.1 Spectrum emission mask Spectrum emission mask

6.6.2.2/5.5.2.2 Adjacent channel leakage power ratio (ACLR) Adjacent channel power

6.6.3/5.5.3 Spurious emissions Spurious emissions

6.7/5.6 Transmit intermodulation Spectrum analyzer mode 

6.8.2/5.7.1 EVM (Error vector magnitude) Modulation accuracy

6.8.3/5.7.2 Peak code domain error Code domain

Demonstration Preparation

All demonstrations use an X-Series 

signal analyzer and the N5182A MXG 

vector signal generator. Keystrokes 

surrounded by [ ] indicate front-panel 

keys; keystrokes surrounded by { } 

indicate softkeys located on the 

display.

Helpful tip:

Update your instrument firmware and software to 

the latest version, at

www.keysight.com/find/xseries_software

www.keysight.com/find/signalstudio

http://www.keysight.com/find/xseries_software
http://www.keysight.com/find/signalstudio
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Minimum equipment coniguration requirements 

Product type/ 

instrument

Model No. Required options

MXG (or ESG)  

vector signal  

generator

N5182A (or E4438C) firmware revision 

of MXG A.01.10 or later

 – 503 or 506 – frequency range at 3 GHz or 6 GHz

 – 652 or 654 – internal baseband generator

 – UNV - enhanced dynamic range  

(required for better ACP performance)

Signal Studio  

software for  

TD-SCDMA

N7612B- V1.2.0.0 or later  – 3FP – N5182A connectivity

 – EFP – basic TD-SCDMA option

 – QFP – advanced TD-SCDMA option

X-Series  

signal analyzer

N9000A, N9010A, N9020A, or N9030A 

firmware revision A.06.xx 

or later

 – 503, 508, 507 (EXA and CXA), 513 or 526 – 513 and  

526 not available on CXA.

 – P0x (P03, P08, (P07 for CXA), P13 or P26) –  

preamplifier (one required for PvT measurement of  

BTS Tx Off power of –82 dBm at 1.28 M bandwidth) 

 – 1FP - TD-SCDMA measurement application

 – 2FP - HSPA/8PSK measurement application

TD-SCDMA  

measurement  

application

N9079A

 

Controller PC  

for Signal Studio

 – Install N7612B to generate and download the signal  

waveform into the Keysight MXG via GPIB or LAN  

(TCP/IP) —please refer to the online documentation  

for installation and setup
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Connect a PC (loaded with N7612B 

Keysight Signal Studio for 3GPP 

TD-SCDMA software and Keysight 

I/O libraries) to the N5182A MXG via 

GPIB or LAN. Follow the Signal Studio 

instructions to complete the connec-

tion, then perform the following steps 

to interconnect the X-Series signal 

analyzer and MXG (see Figure 1 for a 

graphical overview):

Demonstration Setup:

Connect the PC, X-Series and MXG

A. Connect the MXG RF output port  

to the X-Series signal analyzer RF  

input port

B. Connect the MXG 10 MHz out to 

the X-Series signal analyzer Ext 

Ref in port (rear panel)  

C. Connect the MXG Event 1 port 

to the X-Series signal analyzer 

Trigger 1 In (rear panel)

Figure 1. Demonstration setup

N7612B TD-SCDMA Signal Studio
LAN/GPIB

MXG RF Out
10 MHz Ref

Event 1

X-Series RF In
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Demonstrations

Demonstration 1: 

Set up TD-SCDMA Signal 
Studio on the MXG 

The Keysight N7612B Signal Studio 

for 3GPP TD-SCDMA is a Windows-

based utility that simplifies the 

creation of standards-based or 

customized TD-SCDMA signals and 

then the parameters are downloaded 

into the MXG vector signal generator, 

which creates the desired waveform.

Instructions Keystrokes

On the MXG

Preset the MXG. 

Check the IP address.

[Preset] 

[Utility] {I/O Conig} {GPIB/LAN Setup} e.g. 
{GPIB Address 20}

On the Signal Studio software

Run the Signal Studio for 3GPP 

TD-SCDMA.

Double-click on the TD-SCDMA shortcut on 

the desktop or access the program via the 

Windows start menu.  

Verify the software is communicating 

with the instrument via the GPIB or 

LAN (TCP/IP) link.

To establish a new connection, click on the 

{System} pull-down menu at the top of the 

Signal Studio program window. Next, select 

{Run System Configuration Wizard}.

Set the basic parameters of the signal 

at center frequency 2 GHz, amplitude 

–20 dBm, and RF output turned ON.

Click Signal Generator at the hardware on 

the explorer menu on the left. Press [Preset] 

green button on the top. Frequency = 2.0 

GHz, amplitude = –20 dBm, RF Output = On, 

ALC = On

Set a test signal in waveform setup. 

According to TS25.142, there are three 

types of test signals defined for the BTS 

transmitter tests -- we will use one in 

this demonstration. 

Single–carrier signals:

 – TS0: Primary common control  

physical channels 1 and 2 (P-CCPCH) 

Active

 – TS4, TS5 and TS6: 8 code channels 

active per timeslot

 – Downlink pilot timeslot: DwPTS.

Click Carrier0 (Basic) under Waveform 

Setup on the explorer menu on the left. The 

active timeslots should be selected under 

the Resource Units setup on the left-side of 

the window. The signal setting should be 

reviewed on the signal studio -> Carrier0 

(Basic). 

Download the signal to the MXG. Click  Generate and Download button on 

the top tool bar. If you encounter any errors, 

please refer to the online help of Signal 

Studio software. 

Save the signal file for future use. File > Save Setting File > TDSCDMA_Demo1.

scp (file name is your choice.)

Export the waveform file for future use. File > Export Waveform Data > TDSCDMA.

wfm (file name is your choice).
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Demonstration 2:

Transmit power 

The transmit power measurement 

is a highly accurate measure of the 

average power in a specified RF burst. 

It measures in-channel burst power. 

It ensures the transmitted RF carrier 

power of either mobile station or 

base station transceivers transmit 

the proper power level for the correct 

receiver operation, directly affect-

ing call quality. In the TD-SCDMA 

measurement, the burst power can 

be determined by a single timeslot, 

above a specified threshold value or 

during detected burst width.

(Standard sub-clauses required 

in TS25.142 chap 6.2 for Node B., 

TS34.122 chap 5.2; 5.4.2; 5.4.1.3;  

5.4.1.4 for UE.) 

In the TD-SCDMA measurement 

application, the following power 

measurement parameters can be 

controlled: 

 – Measurement method: Single  

Time Slot, Measured Burst Width 

and Above Threshold Level 

 – Number of trace averages  

(default to 50) 

 – Trigger source: Free run, video, 

external-2, and RF burst  

(default is External 1 for BTS;  

RF burst for MS)

 – Display results as minimum,  

maximum, and measured output 

power

 – Results in RMS or log averaging

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Select TD-SCDMA mode. If N9079A-2FP 

is installed, it must be TD-SCDMA with 

HSPA/8PSK. 

[Mode Preset] [Mode] {TD-SCDMA with 

HSPA/8PSK}

Set the center frequency at 2.0 GHz. [Center Freq] [2] {GHz} 

Choose transmitter radio device for base 

station.

[Mode Setup] {Radio} {Device BTS MS}

Run a transmit power measurement. [Meas] [Transmit Power] 

Set the reference level offset for  

DUT lost compensation (Figure 2)

[Input/Output] {External Gain}

Select {MS} or {BTS} for the DUT you are 

testing

 – Enter the number of compensation loss  

of the DUT

In this demonstration, we enter –6 dB of 

external gain to compensate for the cable 

and power splitter. 

Figure 2. Single traffic timeslot (TS0 in this demonstration) transmit power measurement
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Demonstration 3:

Power versus time (PvT)

Time Division Duplex (TDD) is used 

in TD-SCDMA to separate the uplink 

and downlink. The timing is critical 

in the TD-SCDMA time-slot-based 

transmission format. A burst signal 

in a given time slot must fit within a 

tight mask so as not to interfere with 

adjacent time slots. The TD-SCDMA 

standard has a stringent dynamic 

range requirement of 112 dB for base 

stations, which requires measurement 

of Tx Off power levels of –82 dBm for 

the Transmit ON/OFF Time Mask, 

for the maximum power (Tx ON). The 

Keysight X-Series signal analyzers  

support input signal level up to 

+30 dBm (1 W). To perform this 

large dynamic range measurement 

within a 1.6 MHz bandwidth, a special 

measurement algorithm must be 

employed, replacing traditional swept 

measurements in a general purpose 

spectrum analyzer. 

Keysight makes a significant and 

excellent solution of the PvT mea-

surement using two sweeps with 

different attenuator and preamp 

setups. The first sweep minimizes 

the instrument internal noise floor, 

with the internal preamp enabled and 

attenuation minimized to measure 

the noise floor. The second sweep is 

with the instrument internal settings 

of preamp and attenuation to ensure 

accurate measurement of the burst’s 

Tx On power level as calculated by 

the auto RF range algorithm. Then 

the measurement result is combined 

in create one trace to display the 

power versus time. In this method, 

the measurement exhibits the true 

power variations throughout the burst 

or time slots. It also provides a pass/

fail function to quickly indicate if the 

signal is entirely within the mask and 

conformant to the standard.

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Active power versus time measurement. [Meas] {Power vs Time}

Select TS4 as the first time slot for a view of 

the whole burst signal.  

[Mode Setup] {Analysis TimeSlot} > 

{More 1 of 2} > {TS4}

Make a 9 time slots PvT measurement

(Figure 3).

[Meas Setup] {Meas Interval} {9} 

{Enter} [Restart] 

Zoom in for ramp-up or ramp down details 

(Figure 4). 

 

[SPAN X Scale] {Scale/Div}

Enter 10 us of Scale/div, Adjust {Ref 

Value} to put the trace to a best display 

position. 

Turn On the Trigger Line and Burst Line for 

trigger delay adjustment.

[View/Display] {Trigger Line On} {Burst 

Line On} or refer to the “Trigger Diff” 

value in the metrics window. 

Figure 3. The PvT measurement of 9 time slots or one 5 ms sub-frame
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Figure 4. A view of PvT ramp up with burst line and trigger line on

(Standard sub-clause required in 

TS25.142 chap 6.5 for Node B. or  

TS34.122 chap 5.4.3; 5.4.4 for UE.)

 – Tx OFF Power

 – Tx ON/OFF Time Mask

 – Use a standard-compliant,  

consecutive timeslot power vs. 

time mask 

 – Measure Tx ON/OFF power

 – Trigger from RF burst trigger for  

UE signal

 – Trigger delay and ramp-up/down 

time 

 – User-adjustable mask delay

 – Change X-scale to zoom in for 

ramp-up/down details 
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Demonstration 4: 

Adjacent channel power (ACP)

The ACP test verifies the ability of 

BTS or UE to limit the interference 

produced by the transmitted signal 

to other UTRA receivers operating at 

the first or second adjacent RF chan-

nel. The ACP, defined by the 3PGG 

TD-SCDMA TDD specifications as the 

adjacent channel leakage power ratio 

(ACLR), is a measure of the power 

in adjacent channels relative to the 

transmitted power. The standard 

requires the power of both the trans-

mitted and adjacent channels be mea-

sured through a root raised cosine 

(RRC) filter with a roll-off factor  

of 0.22 (α=0.22) and measurement 

bandwidth equate to the chip rate.

(Standard sub clauses required in 

TS25.142 chap 6.6.2.2 for Node B.  

and TS34.122 chap 5.5.2.2 for UE.)

 – For BTS, ACLR of >40 dB in the 

adjacent channel, >45 dB in the 

alternate channel

 – For UE, ACLR of >33 dB in the 

adjacent channel, >43 dB in the 

alternate channel

 – Default standard-compliant limit 

lines with Pass/Fail indication

 – Adjust integration bandwidth for 

the offsets (default to 1.28 MHz)

 – Limit line customization of  

selection up to six channel offsets 

(relative and absolute)

 – View bar graph over spectrum trace  

 – Use default averaging detector 

(RMS) and integration bandwidth 

for speed and accuracy  

 – Noise correction On/Off  

(default to Off)

 – Choose Gate View to see the ACP 

of the measured time slot 

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Active adjacent channel power measurement. [Meas] {ACP}

Adjust the limit for one offset pair.

Notice as the green PASS indicator in the upper 

left corner changes to red FAIL when the signal 

does not meet limit requirements. 

[Meas Setup] {Offset/Limit} > 

{More 1 of 2} {Rel Lim (Car)} > [90] 

{-dB}

Compare the measurement result with Noise 

Correction turned On. A better ACP result is 

achieved with noise correction (Figure 5).

[Meas Setup] {More 1 of 3} {More 

2 of 3} {Noise Correction On Off}

Show Gate View. Notice the ACP is a gated ACP 

measurement of the active time slot (Figure 6 is 

showing the ACP of TS0). 

[Sweep/Control] {Gate} > {Gate 

View On}

Figure 5. ACP with fail indicator on limit test and noise correction
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Figure 6. ACP and Gate View of TS4 on one display

Multi-carrier power is similar to  

adjacent channel power, but measures  

the power in two or more transmit 

channels and the power that leaks 

into their adjacent channels. It is 

used to monitor power amplifiers 

that transmit two or more carriers 

simultaneously. 

(Standard sub clause required in 

TS25.142 chap 6.6.2.2 for Node B.)

 – Default standard-compliant limit 

lines with Pass/Fail indication

 – Supports up to 12 carriers

 – Limit line customization of  

selection up to six channel  

offsets (relative and absolute)

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Active multi-channel power  

measurement. Enter the number of  

carriers to be measured. (Figure 7).

[Meas] {ACP}  

[Meas Setup] {Carrier Setup} > {Carrier} > 

6 {Enter};

Configure carriers to change or specify any 

parameter for each carrier.   

{Carrier Setup} {Configure Carriers} > 

{Carrier 1, or 2, or more } etc. 

Figure 7. Power measurement of six carriers 
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Demonstration 5: 

Spurious emissions

The spurious emissions measure-

ment identifies and determines the 

power level of spurious emissions in 

3GPP TD-SCDMA defined frequency 

bands. This measurement can verify 

the ability of the BTS or UE to limit 

the interference caused by unwanted 

transmitter effects to other systems 

operating at frequencies away from 

the carrier frequency. In the X-Series, 

the range of frequencies to search 

for spurs is user-adjustable, and up 

to 200 spurs can be reported in a 

result table. 

   

(Standard sub clause required in 

TS25.142 chap 6.6.3 for Node B.  

or TS34.122 chap 5.5.3 for UE.)

 – Supports the requirement of the BS 

mandatory limits 

 – Performs measurements conformant  

to MS General and Additional 

Spurious Emissions Requirements

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Active spurious emissions. [Meas] {Spurious emissions} 

Edit the range table as needed different 

from the default parameter values. 

[Meas Setup] {Range Table} 

Choose Category A or Category B and 

set the center frequency of emission of 

the last carrier transmitted by the base 

station or mobile.

[Meas Setup] {More 1 of 2} > {Range 

Preset} > {Category A } or {Category B}  

{Freq Setup} > {First Carrier } or  

{Last Carrier} 

For Category B: {TDD lower} and  

{TDD Upper}

Figure 8. Spurious emissions measurement
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Demonstration 6: 

Spectrum emission mask

The spectrum emission mask (SEM) 

measurement measures spurious 

emissions in specified frequency 

ranges and displays the power of the 

spurious emissions in those bands. 

It is required by 3GPP specifications 

and encompasses different power 

limits and measurement bandwidths 

(resolution bandwidth) at various fre-

quency offsets. Figure 9 is a diagram 

of the specification requirements for 

power density versus frequency offset 

from carrier.

(Standard sub clause required in 

TS25.142 chap 6.6.2.1 for Node B.  

or TS34.122 chap 5.5.2.1 for UE.)

With the spectrum emission mask 

measurement: 

 – Quickly verify standard requirement  

of the Node B by choosing 

“Standard” under Limit State

 – Easy-to-view spectrum and tabular 

results are shown simultaneously 

on a single screen

 – Adjustable offset frequency,  

reference bandwidth, and limit 

values (relative and absolute)

Figure 9. TD-SCDMA specifications for BTS (from TS25.142 v5.10.0)

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Activate spectrum emission mask. [Meas] {Spectrum Emission Mask} 

Choose “Standard” to make a quick  

verification for BTS (Node B) SEM test.

[Meas Setup] {Limit State Standard} 

Choose the type of values to display. Observe 

the measurement values change in the lower 

window to reflect the selected type.

[View/Display] {Abs Pwr Freq}  

or {Rel Pwr Freq}  

or {Integrated Power } 

View customizable offsets and limits. 

Measurement parameters as well as limit 

values may be customized for any of the six 

offset pairs, A through F, or for any individual 

offset (Figure 10).

[Meas Setup] {Limit State Manual} 

{Offset/Limit } > {More 1 of 2} > 

{Limits} 

Figure 10. Spurious emissions mask measurement 
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Demonstration 7: 

Occupied bandwidth 

The 3GPP TD-SCDMA specifications 

require the occupied bandwidth 

(OBW) of a 1.28 Mcps signal to be 

less than 1.6 MHz, where occupied 

bandwidth is defined as the band-

width containing 99% of the total 

channel power. 

(Standard sub clause required in 

TS25.142 chap 6.6.1 for Node B.  

or TS34.122 chap 5.5.1 for UE.)

 – Provides Pass/Fail indicators and 

give a large, clear readout of the 

OBW

 – Changeable occupied bandwidth  

% power 

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Measure the occupied bandwidth

(Figure 11).

[Meas] {Occupied BW} 

Adjust parameters . [Meas Setup]

 

Figure 11. Occupied bandwidth measurement

Helpful tip: Measure 99% occupied bandwidth  

and the x dB bandwidth 

In this measurement, the total power of the displayed span  

is measured. Then the power is measured inward from the 

right and left extremes until 0.5% of the power accounted for 

(total 99% occupied bandwidth to be found) in each of the 

upper and lower parts of the span. In accordance with the  

3GPP TD-SCDMA specification, the X-Series defaults to a  

1.6 MHz Pass/Fail limit value. 
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Demonstration 8: 

Power statistics CCDF

The complementary cumulative 

distortion function (CCDF) is a plot 

of peak-to-average power ratio 

(PAR) versus probability and fully 

characterizes the power statistics of 

a digitally modulated signal. The plot 

can be useful in determining design 

parameters for a digital communica-

tions system. It is a very important 

measurement for power amplifier 

design in TD-SCDMA and HSDPA 

base stations, and is particularly 

challenging because the amplifier 

must be capable of handling the high 

PAR which the signal exhibits while 

maintaining good adjacent channel 

leakage performance. Because the 

TD-SCDMA signal is not continuous, 

the CCDF measurement must specify 

the time slot(s) to be analyzed.  

 – Select measurement interval 

for one or more time slots to be 

measured

 – Easily compare to Gaussian  

noise as a reference trace

 – Available trigger sources: video, 

external-1/2, and RF burst

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Measure the CCDF. [Meas] {More 1 of 2} > {Power Stat CCDF} 

Turn on the time slots view. [View/Display] {Slot View On} 

Adjust the measurement interval to three 

active time slots (Figure 12 ).

[Meas Setup] {Meas Interval} > 3 {Enter} 

Figure 12. CCDF of three active time slots
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Demonstration 9:

Modulation accuracy/ 
composite EVM measurement 

Error vector magnitude (EVM) is 

defined in 3GPP conformance tests 

for both Node B and UE. EVM is a 

common modulation quality metric 

widely used in digital communica-

tions. Measurement of modulation 

accuracy and quality are necessary 

to meet standard-defined tests, 

ensure proper operations between 

base station and user equipment, 

and maximize system capacity. The 

TD-SCDMA modulation accuracy 

measurement provides excellent 

methods for measuring the composite 

errors in a TD-SCDMA transmitter. In 

this case, composite signal means all 

of the code channels and the results 

are comprised of Rho, EVM, Peak 

CDE, and more. 

(Standard sub clause required in 

TS25.142 chap 6.8.1 for Node B. or 

TS34.122 chap 5.7.1 for UE.)

Key features:

 – Composite EVM, peak CDE, and 

phase/magnitude/frequency error 

measurement and more

 – Various views of I/Q polar graph, 

I/Q error, and code domain power

 – Capture time summary table and 

peak/average metric for easier 

result analysis

 – Fail indicator reflects any limit 

failed of the composite RMS EVM, 

composite Peak EVM, Composite 

Rho, peak CDE, or composite fre-

quency error of the selected device 

(BTS or MS) 

 – Supports 16QAM and 8PSK by 

using N9079A-2FP

Available views and traces in  
modulation accuracy: 

 – I/Q measured polar graph: Metrics 

(left) and I/Q measured polar vec-

tor graph (right);the measured polar 

data traces are the I/Q chip rate 

data traces in the desired/selected 

timeslot or subframe 

 – I/Q Error (Quad View: Three 

windows of EVM (bottom left), 

magnitude error (top left) and 

phase error (top right) during the 

captured sub-frame length as chip 

traces

 – Code domain power: Power bar 

graph in upper and metrics in lower 

windows; each code channels 

detected as active are listed with 

code number, absolute power in 

dBm and CDE in dB (See Figure 14, 

code domain matrices of TS4 with 

10 active channels)

 – Capture time summary: The 

summary table provides measure-

ment results of multiple slots for 

conformance tests; it highlights the 

selected timeslot with a blue bar 

on the trace and data value in blue 

in summary window

 – Numeric results: Shows details of 

signal quality parameters

 

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Go to the modulation accuracy  

measurement. 

[Meas] {More 1 of 2 } > {Mod Accuracy 

(Composite EVM)} 

Observe the I/Q measured polar  

vector display and quantitative data.  

[View/Display] {IQ Measured Polar Graph} 

(default) 

Analyze the desired timeslot  

(Figure 13). 

[Mode Setup] {Analysis TimeSlot} > {More 

1 of 2} > {TS4} (or other desired timeslot)

Switch to the IQ error view. [View/Display] {I/Q Error (Quad View)}

View code domain power to check the 

channel power and CDE.  

[View/Display] {Code Domain Power} > 

See more views by selecting different view 

button.

Review the list by expanding the view 

with the zoom key in the bottom of the 

front panel (Figure 14).

Press  in the bottom of the front panel to 

select the metrics window, then press 

button to expand the window.

View the capture time summary view. 

(Figure 15).  

[View/Display] {Capture Time Summary} 

View the numeric results (Figure 16). [View/Display] {Numeric Results}
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Figure 13. A view of I/Q polar vector of selected TS4 with composite EVM metrics

Figure 14. Code domain metrics of TS4 with 10 active channels
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Figure 15. Capture time summary view shows timeslot analyzed and parameters of the entire frame

Figure 16. Numeric results view show details of signal quality parameters
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Demonstration 10:

Code domain 

The code domain measurement pro-

vides all of the tools for demodulating 

and analyzing a TD-SCDMA signal in 

code domain. According to the user-

specified sub-frame, timeslot, code 

channel, and spread code length, both 

for uplink and downlink, this measure-

ment helps to verify that each code 

channel is operating at its proper level 

and identify problems throughout the 

transmitter design from coding to the 

RF section. System imperfections, 

such as amplifier non-linearity, will 

present themselves as an undesired 

distribution of power in the code 

domain. 

Instructions Keystrokes

On the X-Series in TD-SCDMA mode:

Activate the code domain measurement. [Meas] {More 1 of 2} > {Code Domain } 

Ensure the desired timeslot is selected.  [Mode Setup] {Demod} > {Analysis 

Timeslot} 

The default view is of the CDP graph and 

metrics windows (Figure 17).

Switch to the IQ error view (Figure 18.) [View/Display] {I/Q Error (Quad View)}

Switch to the result metrics view.

Figure 17. Code domain power (CDP) view shows active and inactive channels, and power metrics of 

active channels
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Figure 18. I/Q error view shows channel magnitude error, phase error, and EVM

Now, we will generate an HSDPA 

signal in the Signal Studio software 

for TD-SCDMA. 

Instructions Keystrokes

On the Signal Studio software:

Modify the waveform setup. Click a green button “+” under the 

Add/Remove Carriers menu, to add a 

“Advanced” signal of carrier 0 (just for 

demo, the basic signal was deleted here). 

Adjust the switch point to re-configure the 

downlink and uplink timeslots. 

Explore the menu of waveform setup, 

change the default setup of “Switching 

Point” from 3 to 1. 

Turn on the HSDPA Channel. Click “HSDPA channel”, change the state 

of each downlink shared channel to “ON.” 

Select 16QAM. Click on HS-DSCH and HS-SCCH chan-

nels, choose 16QAM in the modulation 

column. 

Confirm the test signal condition in the 

detailed channel setup.

Click HS-DSCH and HS-SCCH channels to 

see each channel parameters. 

Download the signal to the Keysight MXG. Press  Generate and Download button 

on the top tool bar. 
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Demonstration 11: 

TD-SCDMA HSDPA  
measurements

  

Figure 19. Code domain view showing HSDPA channel with 16QAM modulation 

 – Top left: code domain power graph 

 – Top right: symbol power trace in yellow

 – Bottom left: I/Q symbol constellation of the selected code channel 

 – Bottom right: symbol analysis results of the selected code channel 

Instructions Keystrokes

On the MXA/EXA TD-SCDMA mode:

Turn on HSDPA/8PSK (Need N9079A-2FP 

installed).

[Mode Setup] {HSDPA/8PSK Enable On}

Active the code domain measurement. [Meas] {More 1 of 2} > {Code Domain } 

Ensure the desired timeslot is selected.  [Mode Setup] {Analysis Timeslot} 

Switch the view to observe the selected 

HSDPA (Figure 19).

[View/Display] {Code Domain}

Change the view to demodulated bits, 

and switch the bit format form binary to 

hexadecimal (Figure 20).

[View/Display] {Demod Bits} >  

Press  to move the selected window 

to the bottom. 

{Demod Bit Format Binary/Hex}
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Figure 20. Code domain demodulated bits in binary format; bottom window contains demodulated 

bits of the selected code channel

Web Resources Product page:  

www.keysight.com/find/n9079a and  

www.keysight.com/find/w9079a

X-Series signal analyzers:  

www.keysight.com/find/X-Series

X-Series advanced measurement applications:  

www.keysight.com/find/X-Series_Apps

Signal Studio software:  

www.keysight.com/find/SignalStudio

Signal generators:  

www.keysight.com/find/sg

http://www.keysight.com/find/n9079a
http://www.keysight.com/find/w9079a
http://www.keysight.com/find/X-Series
http://www.keysight.com/find/X-Series_Apps
http://www.keysight.com/find/SignalStudio
http://www.keysight.com/find/sg
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